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Reviewer’s Guide
VMware 2.0 for Linux
Welcome to the reviewer’s guide for VMware™ 2.0 for Linux®. On the following pages you will fi nd 
several exercises to assist you with the installation, confi guration, and evaluation of our new product. We 
thank you for your time and hope you enjoy reviewing and using VMware 2.0 for Linux.

Most of the exercises in this guide are designed so you can work through them on a stand-alone 
computer. The fi nal exercise, which simulates a tech support environment, assumes that you have a 
network connection to a computer where you can store one or more large fi les — about 500MB each. 

You can fi nd extensive product documentation in the support section of the VMware Web site at 
http://www.vmware.com/support/.

If you encounter any issues in using the product, please contact pr@vmware.com.
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About VMware
VMware is an application that gives you a fully functional PC in a window. Each of these fully functional 
PCs is a virtual machine, running directly on your host computer. With these virtual machines, VMware 
delivers fl exible computing. That means

• Linux users can run Windows applications on Linux.

• Support organizations can save money by reproducing multiple end-user environments on a 
single PC.

• Developers and QA departments can test across a wide range of operating systems and PC 
confi gurations with much less investment in hardware and setup time.

Multiple virtual machines can run side-by-side. For example, users can simultaneously run Microsoft® 
Windows® 95, Windows 2000, and Linux.

With VMware, sharing fi les is easy — it works just as it does on any PC. VMware also lets you cut and 
paste from one virtual machine to another and between virtual machines and the host computer.

Instant Restore brings back the state of a running virtual machine in seconds. You can pop in and out of 
applications in a virtual machine as you need them — without going through a full boot cycle.

VMware’s virtual disks allow new operating systems to be added without repartitioning. Virtual disks 
can be shared from a repository on a network fi le server — saving administration costs and storage 
overhead.

VMware supports full-screen, full-color graphics. Users are not limited to 256 colors. When running 
virtual machines, users can switch between full-screen mode and windowed mode with a hot key.

Each virtual machine is independent from the host computer — operations done in the virtual machine 
will not affect the host. A “blue screen of death” in a virtual machine won’t affect the host computer 
at all.

VMware delivers all of these features in an easy to install and manage package. It’s powerful stuff.

What’s New in Version 2.0?

With this new release, VMware improves the performance of virtual machines and adds a number of 
features to provide greater power and fl exibility to users.

• Suspend to disk and Instant Restore let you put your virtual machine to sleep, then wake it 
quickly when you need to use it again. Your virtual machine picks up right where you left 
off, with the same applications and documents opening, and there’s no wait for the virtual 
machine to boot up.

• SCSI support allows you to defi ne virtual disks and CD-ROM devices as either SCSI or IDE, 
providing added fl exibility for users who need to test software in a variety of confi gurations.

• Removable devices may be disconnected while the virtual machine is running. You can also 
disconnect the device and edit its properties, then reconnect it.  

• VMware Tools for Linux and VMware Tools for Windows are installed from fl oppy image fi les 
that are included in the product.

• Samba is installed and confi gured automatically on the host when you install VMware 2.0 for 
Linux. This makes it simple for you to share fi les between a Linux host and Windows guests.

• Full-screen support is improved.

• Shrink disk lets you reclaim space that’s not being used in a virtual disk fi le.

• Direct serial connections are supported.
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• Sound input is supported and sound output is improved.

• Raw disk support is improved.

Why use VMware?

The list of very practical uses of VMware is long, but here is a sample of users who may want to run 
multiple operating systems: 

• Software developers who write software for different kernels or operating systems.

• Software developers and quality assurance staff who need to run different service pack levels 
for software testing.

• Web developers who want to install different Microsoft Internet Explorer versions in each 
virtual machine for Web site testing. Different Internet Explorer versions cannot be installed on 
a Windows operating system because of system registry confl icts. 

• Technical and customer support staff who want to maintain multiple virtual machines, each 
confi gured to match different end-user operating systems and applications confi gurations. They 
can then quickly switch to whatever environment they need to try to reproduce a problem or 
work with a customer. 

• Corporate IT organizations that insist users run the corporate “standard desktop” yet also allow 
users to install their own applications in a virtual machine “secure sandbox” without affecting 
the standard desktop. 

Who Uses VMware?

• Over 300,000 users worldwide.

• Users at IBM, HP, Rational, and Lucent access Windows applications from Linux.

• Network Associates, LinuxCare, and Excel.Net use VMware to improve technical support and 
help desk operations.

• Over 600 universities and research institutions use VMware.

The VMware product line

VMware, Inc. currently produces two products. VMware 2.0 for Linux runs on Linux host computers. 
Users with Windows NT® 4.0 or Windows 2000 host machines can take advantage of this breakthrough 
virtual machine technology in VMware 2.0 for Windows NT and Windows 2000. 
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Exercise I
Installing and Getting Started with VMware 
Total estimated time to complete: about 95-100 minutes 

Introduction 

This exercise starts with installing VMware and follows through to completing the installation of a guest 
operating system. This is the longest of all the exercises, and most of that time is taken in installing 
a guest operating system inside a virtual machine. You’ll need just a little longer to install a guest 
operating system in a VMware virtual machine than on a native host computer. 

To get a jump-start, you can skip the installation steps and instead use a VMware Ready to Run 
virtual machine. Ready to Run virtual machines featuring several Linux distributions are available on 
CD-ROM. It takes about fi ve minutes to set up a Ready to Run virtual machine.

Exercise I follows through the steps needed to get a VMware virtual machine and guest operating system 
installed, confi gured, and running. This exercise is divided into fi ve parts: 

• Installing VMware
Time needed: about 5 minutes 

• Confi guring a Virtual Machine Using the VMware Confi guration Wizard
Time needed: about 5 minutes 

• Installing a Windows 98 Guest Operating System
Time needed: about 75 minutes 

• Installing VMware Tools for Windows
Time needed: about 10-15 minutes 

• Using the Virtual Machine 

We recommend that reviewers complete at least this fi rst exercise. 

A very quick way to install a guest operating system in a virtual machine is covered in Exercise IV, which 
simulates a tech support environment. In Exercise  IV, you will use the virtual disk you create in Exercise 
I to conduct an almost-instant installation of a guest operating system over a network connection. 

VMware for Linux can be installed on computers running Red Hat™ Linux 5.x, 6.0, or 6.1; Caldera® 
OpenLinux™ 2.2 or 2.3; SuSE™ Linux 6.0, 6.1, 6.2, or 6.3; or TurboLinux™ 6.0. To make the exercises 
easier to follow, we describe the steps you would follow on one specifi c host — a system running Red 
Hat Linux 6.0

Exercise I (B) steps through installing Windows 98 as a guest operating system inside a virtual machine. 
You will need a Microsoft Windows 98 full version installation CD-ROM to work through this 
exercise; an upgrade version will not work.

If you do not have a Windows 98 CD-ROM available you may also install Windows 95, Windows 
NT 4.0, Windows 2000 or any supported Linux distribution inside the virtual machine. In that case, 
follow along with the instructions in the exercises as a general guide to what steps to take, even 
if the details are different. Also refer to the detailed guest operating system installation notes at 
http://www.vmware.com/support/linux/doc/guest_os_linux.html.

System Requirements

VMware for Linux requires a host computer that meets the following system requirements:  

Hardware requirements for the host machine 
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• Pentium® II 266 MHz and above recommended (Pentium class minimum) 

• 96MB or more memory recommended 

• Video adapter supported by the XFree86 Server (to take advantage of our full-screen option)

• 10MB of available disk space for installing VMware 

• At least 500MB of free disk space for installing a guest operating system and applications 

VMware does not run on non-x86 architecture computers such as Apple Power Macintosh or Sun 
Microsystems workstations. 

Software requirements 

• VMware host operating system requirements:
Standard Linux distributions with glibc version 2 or higher and one of the following:

• Kernel 2.0.32 or higher for non-SMP systems 

• Kernel 2.2.0 or higher for SMP systems 

VMware will not run on systems that do not meet these requirements.

• VMware has been tested and is offi cially supported on the following host operating systems 

• Red Hat Linux 5.x, 6.0, and 6.1

• Caldera OpenLinux 2.2 and 2.3 

• SuSE Linux 6.0, 6.1, 6.2, and 6.3

• TurboLinux 6.0

 VMware may run on other Linux distributions; attempting to do so is recommended for expert 
Linux users only. 

• VMware requires an X server: 

• XFree86-3.3.4 or higher release 

• Optional: Netscape Navigator or Communicator required for online help. VMware will install 
and work on a PC without the Netscape browser, but the context-sensitive HTML-based help 
will not be available. 

The exact amount of memory required by VMware is really dictated by the guest operating system and 
applications that the user will run within a virtual machine. For most desktop applications 128MB is a 
good starting point if you are running one virtual machine and have applications active in the virtual 
machine and on the host. 

Typical personal computers today — especially those used by power users, software developers, and 
similar users — exceed the minimum requirements for VMware. Pentium III-based PCs running at 
600MHz are common among power users, and Celeron™ PCs running at 400MHz or faster power 
many sub-US$1,000 PCs. Please be sure that the computer you are using to review VMware meets the 
minimum requirements. 

Note: Some Cyrix processors such as the Cyrix 5x86 are not strictly compatible with the Pentium proces-
sor and do not include a Pentium processor instruction required by VMware. Later Cyrix processors 
do work with VMware. 

Exercise I (A)
Installing VMware 

Estimated time to complete: about 5 minutes 

Prerequisites: You will need both the VMware installer and a license key for this version of the 
product. (Licenses for VMware 1.x for Linux will not work with VMware 2.0 for Linux. Also, licenses 
for VMware for Windows NT and Windows 2000 do not work with any version of VMware for 
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Linux.) You will fi nd links to download the software and register for the evaluation license key at 
http://www.vmware.com/download/download_linux_pre.html.

Note: If you are currently using VMware 1.x for Linux on your test computer and think you may 
wish to return to that version after testing VMware 2.0 for Linux, review the downgrade instructions 
at http://www.vmware.com/support/linux/doc/beta_linux/downgrade_linux_beta.html before you install 
the new version. 

Installing VMware is simple — much like installing any other application on your computer. You may 
install using a gzipped tar fi le or an RPM installer downloaded from the VMware Web site. If you have 
the packaged distribution of the product, you will fi nd both installation fi les included on the CD. 

Networking note
For most of the exer-
cises in this guide, you 
do not need a connection 
to an external network. 
Some do not involve any 
network activity. Others 
can use a virtual net-
work running entirely on 
the host computer.
The fi nal exercise calls 
for a connection to an 
external network.
In the installation and 
confi guration instruc-
tions we suggest that 
you install all the 
VMware networking 
capabilities and initially 
confi gure your virtual 
machine for host-only 
networking.

Installing from a tar fi le
1. You should be logged on to your Linux host with the user name you will 

use when running VMware. 
In a terminal window, become root so you can carry out the initial installation steps. 

 su 

2. From the terminal extract the tar fi le you downloaded:

 tar zxf fi lename.tar.gz (where fi lename.tar.gz is the fi le you downloaded)

3. Change to the VMware installation directory
cd vmware-distrib 

4. Run the install script:
./vmware-install.pl

5. Accept the default directories for binary fi les, library fi les, manual fi les, documentation 
fi les and init script.

6. When prompted to run vmware-confi g.pl, respond with Yes.

 This script can be used to reconfi gure VMware whenever you upgrade your kernel. It is 
not necessary to reinstall VMware.

7. Acknowledge the end user license agreement (EULA).  You may page through it using 
the space bar. If you do not get the “Do you accept …” prompt, you may press Q to get 
to the next prompt.

 
 Figure 1 - 1a 

8. Respond yes to the following prompts:

• Do you want to use the network in your virtual machines? 

• Do you want to be able to use host-only network in your virtual machines?

• Do you want this script to probe for an unused private subnet?

9. Press Enter to display the DHCP server copyright information.

 You may press the space bar to page through it, then press Q to continue to the next 
prompt.

If you upgrade
If you’re already using 
VMware on your test 
computer, be sure to 
read the downgrade 
information on the 
VMware Web site before 
installing VMware 2.0.
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Installing from an RPM fi le
1. You should be logged on to your Linux host with the user name you will 

use when running VMware. 
In a terminal window, become root so you can carry out the initial installation steps. 

 su 

2. From the terminal run the RPM fi le you downloaded:

 rpm -i fi lename.rpm (where fi lename.rpm is the fi le you downloaded)

 Note:  If you are upgrading, the command is

 rpm -Uhv fi lename.rpm (where fi lename.rpm is the fi le you downloaded)

3. Run the confi guration script:
vmware-conÞ g.pl

 This script can be used to reconfi gure VMware whenever you upgrade your kernel. It is 
not necessary to reinstall VMware.

4. Acknowledge the end user license agreement (EULA).  You may page through it using 
the space bar. If you do not get the “Do you accept …” prompt, you may press Q to get 
to the next prompt.

 
 Figure 1 - 1b 

5. Respond yes to the following prompts:

• Do you want to use the network in your virtual machines? 

• Do you want to be able to use host-only network in your virtual machines?

• Do you want this script to probe for an unused private subnet?

6. Press Enter to display the DHCP server copyright information.

 You may press the space bar to page through it, then press Q to continue to the next 
prompt.

7. Accept the defaults for the rest of the prompts.
When prompted for a user name and password to use with Samba confi guration, enter the 
user name you used in step 1 above.

8. When done, log out of the root account.

 exit

10. Accept the defaults for the rest of the prompts.
When prompted for a user name and password to use with Samba confi guration, enter the 
user name you used in step 1 above.

11. When done, log out of the root account.

 exit

Networking note
For most of the exer-
cises in this guide, you 
do not need a connection 
to an external network. 
Some do not involve any 
network activity. Others 
can use a virtual net-
work running entirely on 
the host computer.
The fi nal exercise calls 
for a connection to an 
external network.
In the installation and 
confi guration instruc-
tions we suggest that 
you install all the 
VMware networking 
capabilities and initially 
confi gure your virtual 
machine for host-only 
networking.
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Installing the VMware License

After completing the installation of VMware, you will need to install the VMware license. 

The license you received is in an email fi le attachment (or on the distribution CD) as a text fi le. To 
install it, follow this procedure:

1. Change to your home directory
cd <Enter>

2. If you do not already have a directory named .vmware (notice the leading dot), create one.
ls -al  (you should see a list of all directories; if .vmware exists, go to step 3)
mkdir .vmware

3. Save the license fi le you received in the .vmware directory. Be sure the name of the fi le begins 
with license — in lower case.

Exercise I (B)
Confi guring a Virtual Machine 

Estimated time to complete: about 5 minutes 

Start VMware by typing vmware from within a terminal. 

1. Start the confi guration wizard. 

 When VMware is started, the startup screen has three options: 

• Run the Confi guration Wizard. 

• Run the Confi guration Editor. 

• Open an existing confi guration. 

 
  Figure 1 - 2

 The default selection is Run the Confi guration Wizard. 

 

Defaults
The default settings will 
give good results for a 
general-purpose confi g-
uration. For purposes of 
these exercises, there 
are a few places where 
you should select dif-
ferent settings. We will 
highlight those special 
cases.
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 Figure 1 - 3

 Clicking the OK button starts the confi guration wizard. The Confi guration Wizard can also be 
started from the File menu (choose File > Wizard). 

 Clicking the Help button will open a pop-up window with context-sensitive help. That text will 
also include links to relevant help topics (text in blue — clicking on it will take you to the 
corresponding help topic). 

2. Select an operating system. 

 The fi rst screen asks which operating system will be installed in the virtual machine. The 
Confi guration Wizard uses this information to select appropriate default values, such as the 
amount of memory needed. The wizard also uses this information when naming associated 
virtual machine fi les. 

 If the operating system you are using is not listed, select “Other” and give an appropriate name. 

 For the purposes of this exercise, select Windows 98. 

 Selecting a Directory for the Virtual Machine

 Each virtual machine should have its own directory. All associated fi les, such as the confi gura-
tion fi le and the disk fi le, are placed in this directory. This screen lets you select the virtual 
machine’s directory. 

 The default location for this exercise is the directory ~UserHome/vmware/win98 or 
/home/UserHome/vmware/win98 where UserHome is the currently logged in user’s name. 

 Virtual machine performance may be slower if your virtual hard disk is on a network drive. For 
best performance, be sure that the virtual machine’s directory is on a local drive. 

3. Select the disk type. 

 For this exercise, select Virtual Disk. 

4. Enter the size of the virtual disk. 

 Fill in the size of the virtual disk that you wish to create. For this exercise, use the default of 
2000 (megabytes).

Quick fi nish
When the Confi guration 
Wizard has enough 
information to complete 
the confi guration, the 
Finish button will no 
longer be dimmed. You 
can then click Finish to 
use defaults for all 
remaining options.
These options can be 
changed later using the 
Confi guration Editor 
(Settings > 
Confi guration Editor).

Set disk size 2000
The size you set in this 
step limits the maxi-
mum size of the virtual 
disk. The actual fi le on 
your host machine will 
initially be quite small. 
It will grow as needed 
to hold the operating 
system, applications, 
and data fi les. Once this 
size is set, it cannot be 
changed.
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 Figure 1 - 4

5. Enable the CD-ROM drive. 

 Select whether or not to allow the virtual machine to access the CD-ROM drive. 

 Windows 98 requires the use of a CD-ROM for installation.
For the purposes of this exercise, select CD-ROM Enabled. Type in the path to the CDROM 
device, for example, /dev/cdrom.

 Even if the virtual machine has CD-ROM access enabled, you can disable access to the 
CD-ROM device later during the operation of the virtual machine by using the Devices menu. 
This is useful if you wish to control which of several running virtual machines is allowed to 
access the CD-ROM. 

6. Enable the fl oppy disk drive. 

 
 Figure 1 - 5 

 Select the Floppy Enabled option and choose the device that corresponds to your physical fl oppy 
drive, for example, /dev/fd0. 

 Note that some operating systems may require the use of a fl oppy drive during installation. 

 Even if the virtual machine has fl oppy disk access enabled, you can disable access to the fl oppy 
disk device later during the operation of the virtual machine by using the Devices menu. This 
is useful if you wish to control which of several running virtual machines is allowed to access 
the fl oppy disk.  
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 Figure 1 - 6

7. Confi gure the networking capabilities of the virtual machine. 

 For this exercise, select Host-only Networking.

 This screen lets you select the option that applies to this virtual machine. 

 See Exercise III for more details about VMware networking options. 

 
 Figure 1 - 7

8. Review and fi nish the confi guration: 

 This fi nal screen presents you with all the options you have selected. Review it for accuracy and 
click the Done button to complete the virtual machine confi guration. 

 If you want to change any of these settings, the Prev button will take you to the earlier screens, 
where you can make the changes. 

 Note that most confi guration settings can be viewed and modifi ed using the Confi guration 
Editor, which you can fi nd on the Settings menu (Settings > Confi guration Editor). 

Self-contained 
virtual network
For most uses, Bridged 
Networking is the sim-
plest choice. However, 
selecting Host-only 
Networking in this step 
prepares you for 
Exercise III, which lets 
you explore VMware 
networking without a 
connection to a physical 
network.
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Exercise I (C)
Installing a Windows 98 Guest Operating System 

Estimated time to complete: about 75 minutes 

To install the operating system on your virtual machine, you may follow this procedure: 

1. Insert the Windows 98 CD in your CD-ROM drive. 
Note: If you cannot boot from your Windows 98 installation CD, also insert the bootable 
installation fl oppy disk in your fl oppy disk drive.

 
 Figure 1 - 8 

2. Power on the virtual machine (by clicking the Power On button). You will see the VMware 
BIOS identifi cation, and the virtual machine will run the power on self test. 

3. Click anywhere inside the virtual machine window and select Boot from CD-ROM when boot 
options are displayed.

 
 Figure 1 - 9 

4. The virtual machine will boot from the Windows 98 CD-ROM and the Windows 98 Startup 
Menu will be displayed.
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5. Select Start Windows 98 Setup from CD-ROM.

 
 Figure 1 - 10

6. The Windows 98 Setup welcome screen will display.

7. Press Enter to continue installing Windows 98 in the same manner you would on a physical 
PC, with the following considerations: 

a. During this session, the keyboard and the mouse are grabbed by the virtual machine. 
If you need to release the cursor, you may do so by pressing the Ctrl-Alt-Esc keyboard 
combination. 

 Note that Windows 98 Setup will detect the virtual devices rather than the physical devices 
installed in your computer.  

  
  Figure 1 - 11 

b. When fdisk displays your hard disk information, it is actually referring to the virtual disk 
rather than your physical hard disk. Partitioning and formatting the virtual disk will NOT 
affect your physical hard disk partitions.  

Fdisk, format
You need to run fdisk 
and format during the 
installation, as if you 
were preparing a new, 
unformatted hard drive. 
These steps affect only 
your virtual disk, which 
is contained in a fi le 
on your host computer’s 
fi le system. They do not 
repartition or reformat 
the physical hard disk on 
your host computer.
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  Figure 1 - 12 

c. The virtual network card that setup will detect is an AMD PCNET Family Ethernet 
Adapter.  

  
  Figure 1 - 13 

d. Select TCP/IP as the network protocol and use DHCP. This will utilize the DHCP server 
installed during VMware installation. 
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  Figure 1 - 14 

e. The video card detected by setup is a VGA card. Accept the default selections, including 
the resolution and color. The VMware Tools provide enhanced graphics. You will install 
the tools in Exercise I(D). 

Exercise I (D)
VMware Tools for Windows 

Estimated time to complete: about 5 minutes 

Prerequisites: complete Exercises I (A) through I (C) 

Introduction to VMware Tools 

With the VMware Tools SVGA driver installed, VMware supports up to 32-bit displays and high display 
resolution, limited by the capabilities of the host computer’s display adapter. The VMware SVGA driver 
will also make use of 2-D hardware acceleration, signifi cantly speeding up overall graphics performance 
within a virtual machine. 

In addition to the SVGA driver, the VMware Tools package includes a small background VMware Tools 
utility that implements the following features: 

• Text buffer for cut and paste between virtual machines and the host operating system and 
among virtual machines 

• Control of the VMware mouse cursor behavior, allowing you to move the mouse cursor freely 
from the virtual machine window to the host machine’s display and back 

• The ability to connect VMware removable devices (such as fl oppy and CD-ROM drives) to the 
virtual machine — and disconnect them — from within the guest operating system 

• The ability to shrink the virtual disk fi le to reclaim unused space

• Time synchronization between guest and host

These enhancements are available only when VMware Tools is running. 

Installation fi les for VMware Tools for Linux and VMware tools for Windows are built into VMware 
(Settings > VMware Tools Install). 

Tools needed for 
best performance
It is very important that 
you install VMware 
Tools in the guest oper-
ating system. 
Although VMware will 
run a guest operating 
system even if you do 
not install VMware 
Tools, the graphics envi-
ronment within the vir-
tual machine will be 
limited to VGA mode 
(640x480, 16 color). The 
graphics within the vir-
tual machine will also 
be slow and make no use 
of any hardware accel-
eration. This graphics 
slowdown can make the 
virtual machine annoy-
ingly slow. 
VMware Tools are 
available for:
• Windows (Windows 95, 
   Windows 98, Windows
   NT 4.0, and Windows
   2000 all use the
   same VMware Tools)
• Linux
• FreeBSD



Reviewer’s Guide
VMware 2.0 for Linux 16

Copyright © 2000 VMware, Inc. All rights reserved.

Installing VMware Tools for Windows 

The following instructions assume that this is the fi rst time you have installed and confi gured VMware 
on the computer you are using for these exercises. If you previously installed an earlier version of 
VMware and wish to use a virtual machine you defi ned at that time, be sure that VMware Tools is not 
running when you install the upgrade.

To install VMware Tools in a Windows guest operating system: 

1. Power on the virtual machine. 

2. Reconfi gure your virtual machine to install the VMware Tools.
Choose Settings > VMware Tools Install

3. Double-click the My Computer icon on your desktop. 

4. Double-click the A: drive. 

5. Double-click VMwareTools.exe and follow the instructions. 
Instructions for confi guring the video driver will open automatically in Notepad at the end 
of the installation process. If the Notepad window is hidden, bring it to the front by clicking 
the Notepad button on the Windows 98 taskbar. Follow the detailed instructions presented in 
the Notepad window.

 
 Figure 1 - 15 

6. After restarting the Windows 98 virtual machine, open the device manager and verify that the 
display adapter is VMware SVGA(FIFO).

 You should notice the presence of a Standard PCI Graphics Adapter too.

Confi guring VMware Tools

VMware Toolbox is loaded to the system tray on startup. 
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To confi gure VMware tools:  

 
 Figure 1 - 16

1. Right-click the VMware Tools icon in the system tray. 

2. Click Options.... (The above two steps can be achieved by double-clicking the icon in the system 
tray.)  

 
 Figure 1 - 17 

3. The VMware Toolbox cursor options are: 

• Release input focus when the mouse leaves the virtual machine

• Capture input focus when the mouse enters the virtual machine 

• Scroll when mouse nears edge of the virtual machine 

• Hide cursor when the virtual machine loses input focus 

• Bring the virtual machine to top when it gets input focus

 The VMware Miscellaneous Options are:

• Allow copy and paste to and from the virtual machine

• Time synchronization between the virtual machine and the host operating system (new 
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feature in this release) 

4. The Devices tab of the VMware Toolbox options allows you to enable or disable removable 
devices. (You can also set these options by right-clicking the VMware Tools icon in the system 
tray, then clicking Devices, or navigate to them from the Devices menu of the VMware applica-
tion.) 

 
 Figure 1-18

5. The Shrink tab gives you access to the settings you need if you wish to reclaim 
unused space in a virtual disk.
Note: Shrinking a virtual disk may be a time-consuming operation.

Exercise I (E)
Using the Virtual Machine

Shutting Down a Virtual Machine 

To shut down a virtual machine, you may follow this procedure: 

1. Choose Shut Down from the Start menu of the guest operating system (inside the virtual 
machine). 

2. Select the “Shut down” radio button, then click OK. 

3. After the guest operating system shuts down, it is safe to exit the VMware application. 

Starting a Virtual Machine 

To start the virtual machine that you confi gured above: 

1. Open a Terminal, type vmware and press Enter. 
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 Figure 1 - 19 

2. Select the “Open an existing confi guration” radio button, then click OK. 

 
 Figure 1- 20

3. Browse to your virtual machine’s directory. Highlight the win98.cfg fi le, then click OK.
Or if the confi guration you want is listed among the recently used confi gurations shown in the 
dialog in fi gure 1-19, click the confi guration fi le name to highlight it, then click OK.

4. Click the Power On button to power the virtual machine on.

Using Suspend and Instant Restore

In VMware for Linux 2.0, you can now save the current state of your virtual machine to disk. Then 
the new Instant Restore feature lets you quickly pick up work right where you stopped — with all the 
applications and documents you were working on open and at the ready.

The speed of the suspend and restore operations depends on how much has changed during your 
working session. In general, the fi rst suspend will take a bit longer than later suspends do. 

To suspend a virtual machine:

1. When the virtual machine you started in the last section is running, open WordPad.
Start > Run 
WordPad

2. Type in a few words.

Quick switch
If you have several vir-
tual machine confi gura-
tions suspended to disk,  
you can move quickly 
from one to another.
Click Suspend to save 
the state of the current 
virtual machine. Then 
use File > Instant 
Restore VMs to display a 
list of quickly available 
virtual machines.
Or if you want to have 
both virtual machines 
running at the same 
time, just launch a new 
instance of VMware.
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 Figure 1 - 21

3. If your virtual machine is running in full-screen mode, return to window mode by pressing 
the Ctrl-Alt-Esc key combination.

4. Click Suspend on the VMware button bar.

 
 Figure 1 - 22

5. Quit VMware.
File > Exit

To restore a virtual machine that you have suspended:

 
 Figure 1 - 23

1. Start VMware and choose the virtual machine you just suspended. The process is the same as 
that described in steps 1–3 of Starting a Virtual Machine above.

2. Click Resume on the VMware button bar.
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 Figure 1 - 24

3. Note that WordPad is running and the text you typed before suspending the virtual machine 
is displayed.
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Exercise II
VMware Virtual Machine Sharing 
Estimated time to complete: about 5 minutes 
Prerequisites: Exercises I (A) through I (D) completed 

Introduction to VMware Virtual Machine Isolation 

VMware virtual machines provide a high degree of isolation from other virtual machines and from 
the host operating system. Installing software in the virtual machine, accidentally infecting a virtual 
machine with a computer virus or even having a virtual machine crash will not affect other virtual 
machines or the host operating system. 

Although it provides a high level of isolation, VMware still allows convenient sharing when a user 
desires, including cutting and pasting, networking, and fi le sharing between virtual machines and the 
host operating system or between two or more virtual machines. 

Exercise II will demonstrate simple sharing using cutting and pasting between a virtual machine and 
the host. In a later exercise you can see other forms of sharing between environments with VMware 
virtual networking and fi le sharing. 

Cutting and Pasting 

Cutting and pasting is an example of the easy sharing between VMware virtual environments. The 
VMware Tools installed in Exercise I (D) provide the capability to cut and paste between one virtual 
machine and another or between a virtual machine and the host operating system. 

In this exercise we will use a very simple example of copying and pasting between Microsoft WordPad 
and kedit on the guest and host operating systems. VMware’s copy and paste functions allow a user to 
use the native copy and paste methods for a particular operating system. 

1. Start VMware and power on the Windows 98 guest operating system if it is not already running. 

2. Log in to Windows running inside the virtual machine as any user. 

 
 Figure 2 - 1

3. Check to be sure VMware Tools is running in the guest operating system. There will be a 
tools icon in the system tray (the default position is the right end of the taskbar) in the guest 
operating system. 

4. On the guest operating system choose Start > Run and enter WordPad. 

5. Start typing any text into WordPad. 



Reviewer’s Guide
VMware 2.0 for Linux 23

Copyright © 2000 VMware, Inc. All rights reserved.

 
 Figure 2 - 2

6. Select a range of the text you have entered and copy the text using Ctrl-C or the Edit > Copy 
menu item. 

7. On the host computer open an editor — kedit, for example. 

 
 Figure 2 - 3

8. Click the middle mouse button inside the editor to paste the contents of the clipboard into 
the new fi le. 

9. You can repeat this exercise going in the reverse direction by typing more text, copying this, 
then pasting it back into WordPad running inside the virtual machine. 
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Exercise III
Virtual Networking in VMware 
Estimated time to complete: about 10-15 minutes 

Each virtual machine can have its own distinct network confi guration. There are four choices for 
confi guring networking: 

• No networking 

• Bridged networking 

• Host-only networking 

• Custom networking 

In this exercise, you will confi gure and test a host-only network. This will give you a chance to explore 
VMware’s networking capabilities even if your test computer is not connected to a physical network. But 
fi rst a quick description of the networking options in VMware.

No networking 

• The virtual machine is run in isolation. 

• It will not be able to communicate with the host operating system. 

• It will not be able to communicate with any other virtual machine running on the host. 

• This option is useful if you desire complete isolation for testing or security purposes. 

• To set up your virtual machine in this way, simply do not install a network interface adapter 
when confi guring the virtual machine. 

Bridged networking 

• The virtual machine runs on a virtual network that is connected to an existing physical 
network. 

• It permits the virtual machine to appear as a full-fl edged host on an existing physical network. 

• The virtual machine may transparently use any of the services available on the network that it is 
bridged to: printers, fi le servers, gateways, etc. 

• Any physical host, or other virtual machine confi gured with bridged networking, can use 
resources on that virtual machine. 

• This is the most commonly used networking confi guration. 

Host-only networking 

• The virtual machine can communicate with the host operating system. 

• It can also communicate with other virtual machines set up to use host-only networking. 

• The virtual machine cannot communicate with any systems beyond the host machine without 
the use of a proxy server or IP masquerading. 

• It utilizes VMware’s DHCP daemon, installed on the host during VMware installation. 

This networking type is most useful when: 

• You want to isolate your virtual machines from systems outside the host computer. 

• The host is not connected to any physical network. 

• No Ethernet network adapter is installed on the host. 

• The network adapter is something other than Ethernet (for example, Token Ring). 

• A modem is installed and confi gured to dial to an Internet service provider. 
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Custom networking

Refers to any network confi guration other than those described above. This is outside the scope of 
this exercise. 

Confi guring Host-Only Networking 
To confi gure host-only networking you may follow this procedure: 

1. Start VMware as outlined in Exercise I (E) using the Windows 98 confi guration fi le. 

2. Choose the Settings > Confi guration Editor menu option. 

 
 Figure 3 - 1 

3. Expand Ethernet Adapters by clicking the + next to it. 

4. Highlight Ethernet and select the Host-only Connection Type if is not already selected. 

5. Click OK. 

6. Choose the File > Save menu option to save the changes to the confi guration fi le. 

7. Power on the virtual machine (by clicking the Power On button). 

8. After the Windows 98 guest operating system is started and you have logged in, right-click the 
Network Neighborhood icon on the desktop, then choose Properties  
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 Figure 3 - 2 

9. Select TCP/IP -> AMD PCNET Family Ethernet Adapter. 

10. Click Properties. 

 
 Figure 3 - 3 

11. Verify that “Obtain an IP address automatically” is selected. 

12. If you did not need to make any changes, click Cancel, then Cancel again. If you made any 
changes, click OK, then OK again and restart Windows 98 when prompted. 
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 Figure 3 - 4 

13. Choose Start > Run and enter winipcfg.

14. Select “AMD PCNET Family Ethernet Adapter” instead of the PPP adapter.

15. Verify that an IP address lease has been assigned (in our example it is 172.16.116.128). 

16. Switch to the host operating system and open a terminal, then become root. 
su <enter> then type the root password

 
 Figure 3 - 5 

17. Run 
ifconÞ g vmnet1 
Vmnet1 is the virtual Ethernet adapter used for host-only networking (in contrast to bridged 
networking, which uses vmnet0 as the virtual Ethernet adapter).

18. Also notice that the host’s IP address is the fi rst in the subnet (in our example, the IP address is 
172.16.116.1 and the network number is 172.16.116.0 based on subnet mask of 255.255.255.0). 

19. Another important item to notice is that the guest operating system is acquiring its IP lease 
from a DHCP server whose IP address is the last in the above subnet (in our example it is 
172.16.116.254).  
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 Figure 3 - 6 

20. While still at the host’s terminal, ping the virtual machine’s IP address. It should respond 
successfully. 

21. Exit the terminal. 

 
 Figure 3 - 7 

22. Switch back to the guest and open a command prompt. Ping the host’s IP address. It should 
respond successfully. 

23. Exit the command prompt. 

You have now seen the virtual network in action. You may use any services available on the network. For 
example, if you have a Web server running on your host, you can browse its pages from a Web browser 
on the guest, or vice versa. Or you can share fi les between host and guest using Samba. When you install 
VMware 2.0 for Linux, Samba is confi gured automatically so it will support fi le sharing between the 
Linux host and a Windows guest operating system.

24. On your host machine, verify that you have confi gured Samba using the IP address of the 
virtual Ethernet adapter mentioned in steps 17 and 18 above. 

• Switch to the host.

• Start a terminal.

• Become root
su

• Issue the following command and examine the content for the IP addresses you 
found in step 18.
less /etc/vmware/vmnet1/smb/smb.conf



Reviewer’s Guide
VMware 2.0 for Linux 29

Copyright © 2000 VMware, Inc. All rights reserved.

25. If you have confi gured Samba on your host before installing VMware, stop it before proceeding.
To stop the Samba service:

a. su

b. /etc/rc.d/init.d/smb stop

26. On your virtual machine do the following: 

a. On the Windows 98 virtual machine, double-click Network Neighborhood and browse to 
the host computer’s icon. 

b. The shares on the host should appear similar to those shown in fi gure 3-8 below. 

 
 Figure 3 - 8 

27. You may copy fi les back and forth from host to guest just as you would between two computers 
on a physical network.
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Exercise IV
Sharing VMware Virtual Disks on a Network 
Estimated time to complete: about 20-30 minutes 

Introduction to VMware Disk Capabilities 

VMware supports two disk types: existing disk partitions (also known as raw disks) and virtual disks. 

Virtual disks are particularly convenient for many users — for example, technical support representa-
tives or quality assurance groups — because they encapsulate a virtual machine in a fi le on the host 
computer’s fi le system. This fi le can then be stored on a fi le server or CD-ROM for later use and can be 
shared with other users. A variety of operating systems and system confi gurations can be maintained as 
virtual disk fi les for quick access by anyone in the group.

A virtual disk fi le created under VMware for Linux can be used under VMware for Windows NT and 
Windows 2000 and vice versa.

A VMware virtual machine can use disks in three modes: persistent, nonpersistent, and undoable. 
The default mode is persistent. Persistent disks behave as conventional disks do, with changes made 
permanently. With nonpersistent disks, changes are discarded at the end of each session. Undoable disks 
allow users to choose whether to keep or discard changes.

In this exercise you will see how to change disk modes, then set up client and server computers for 
easy sharing of virtual disks.

Exercise IV (A)
Confi guring an Undoable Disk 

To confi gure a virtual machine to use undoable disk mode, you may follow this procedure: 

1. Start VMware and choose the virtual machine you confi gured in Exercise I. 

2. Choose the Settings > Confi guration Editor menu option. 

 
 Figure 4 - 1 

3. Expand the IDE Drives tree by clicking the + next to it.  

Protect your work
Many VMware users 
routinely use undoable 
disk mode as an easy 
way to protect their 
system confi gurations.
When you have your vir-
tual machine set up in 
a way you like, commit 
all changes as outlined 
in this section.
You should also click the 
Commit button any time 
you shut down a session 
where everything 
worked as you wanted it 
to.
Or if you’re not sure 
about changes you 
made, click Keep. This 
lets you decide later 
whether to commit or 
discard the changes.
But if something goes 
wrong — errors while 
installing a program, 
document changes you 
wish you hadn’t made, 
even a system crash —  
shut down the virtual 
machine and click 
Discard instead. Next 
time you start your vir-
tual machine, you’ll be 
back were you were 
before the session that 
spelled disaster.
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 Figure 4 - 2 

4. Select the drive P-M Virtual Disk and choose Undoable from the pick list. 

5. Click Save to save the changes to the confi guration fi le. 

6. Power on the virtual machine (by clicking the Power On button). 

7. After the Windows 98 guest operating system is started and you have logged in, locate the 
Win98 virtual machine directory and list its contents. Notice the presence of a new fi le called 
Win98.dsk.REDO. This is the redo log, which temporarily stores changes you make during 
your work session. 

8. Install an application of your choice on the virtual machine. Use something that doesn’t take 
long to install, because you will discard this application in one of the following steps. 

9. Shut down Windows 98 on the virtual machine and click the Power Off button. 

 
 Figure 4 - 3 

10. You are prompted with three possible actions for the redo log: 

• Commit 

• Discard 

• Keep 

11. Click Keep. 

12. Power on the virtual machine.  

 
 Figure 4 - 4 

13. You are prompted with four options for the redo log: 

• Commit: to commit the contents of the redo log to the virtual disk 

• Discard: to discard the contents of the redo log and start with a new log 

• Append: to append new changes in this session to the existing log 

• Cancel: to cancel the redo operation, after which you will have an option to cancel the 
session or continue with the disk disabled 

14. Click Append 
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15. After Windows 98 has started and you are logged in, check for the application you installed in 
step 8 above. Notice that it is still installed. 

16. Shut down Windows 98 and power off the virtual machine. 

17. You are again presented with the same dialog as in step 10 above. 

18. Click Keep. 

19. Power on the virtual machine. 

20. The dialog listed in step 13 above is now displayed. Click Discard. 

21. After Windows 98 has started and you are logged in, check for the application you installed in 
step 8 above. Notice that it is no longer there. 

22. Install an application that you want to keep. 

23. Shut down Windows 98 and power off the virtual machine. 

24. Click Commit. A progress bar will appear while the changes are committed to the virtual disk. 

25. Power on the virtual machine. 

26. Notice that you no longer see the dialog listed in step 13. 

27. After Windows 98 has started and you are logged in, check for the application you installed in 
step 22 above. Notice that it is still installed. 

28. Shut down Windows 98 and power off the virtual machine. 

29. Click Commit. 

Exercise IV (B)
Sharing Virtual Disks from a Network Drive 

In this exercise you will go through the basic steps needed to set up virtual disks so they can be 
shared from a network drive. Shared virtual disks are important time-savers for VMware customers like 
Internet service provider Excel.Net.

“VMware lets us quickly fi re up a virtual machine to match the customer’s confi guration,” says Excel.Net  
President Larry Weidig. “It’s great for customer support.”

Figure 4 - 5

In this exercise, you will store virtual disk fi les on a network drive and set up a client computer to use 
that virtual disk without changing the shared fi les. You willl need to copy some fi les to the network 
server and modify your VMware confi guration to run the virtual machine from the server.

Reference library
The customer support 
group at Excel.Net has 
a shared fi le server that 
contains virtual disks 
with the many operating 
system and browser 
combinations their cus-
tomers use. Each cus-
tomer support repre-
sentative has VMware 
installed and can use 
any of the virtual disks 
to replicate the custom-
ers’ environments. 
For example, one user 
may call and have 
Windows 95 running 
Microsoft Internet 
Explorer 4, while the 
next customer will have 
Windows NT and 
Internet Explorer 5. It 
is invaluable to be able 
to step through exactly 
what the user sees, 
since the network con-
fi guration dialogs are 
different on each oper-
ating system.
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1. Locate the virtual machine directory you created in Exercise I (in our example it was /home/
username/vmware/win98). You should have the following fi les among others: 

• Win98.cfg (the virtual machine’s confi guration fi le) 

• Win98.dsk (the virtual disk fi le)  

2. Mount a network drive on which you will store the fi les. 

3. Copy the .cfg and .dsk fi les from the directory identifi ed in step 1 to the mounted network 
drive. 

4. CD into the mounted drive and directory, then assign the group you will use as VMware users 
read-write access to the .dsk fi le. 

5. Start VMware using the .cfg fi le on the network drive.
vmware win98.cfg

6. Start the Confi guration Editor (Settings > Confi guration Editor).  

 
 Figure 4 - 6

7. Expand the IDE Drives tree, then highlight P-M Virtual Disk. 

8. Notice that the virtual disk name fi eld is still pointing to the original path. 

9. Edit the above path to refl ect the new location on the network. In our example /mnt/vdisks/
win98/win98.dsk, where vdisks is the mounted network drive. 

 
 Figure 4 - 7 

10. Change the virtual disk mode to Nonpersistent.  
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 Figure 4 - 8

11. To improve disk I/O performance, set the redo log directory to a local drive. To do so: 

a. Click Misc in the left pane. 

b. In the Redo Log Directory fi eld type in the path to a directory on the local drive.

 In our example, the directory is on /local/redo/win98. 

 Note: You set the disk mode to nonpersistent because multiple users will be modifying the disk 
at the same time. You want to prevent their modifi cations from being committed to the disk. 
This is the safest method for sharing the same virtual disk.

 If you want to allow users to keep their changes between sessions (but not commit the changes 
to the shared virtual disk), you can do the following: 

c. Set the disk mode to undoable. You can do that by selecting Undoable instead of Nonpersis-
tent in step 10 above. 

d. Change the fi le attribute of the shared .dsk fi le to read only.

 This will allow the users to keep their changes but not commit them to the virtual disk.
Note: If you use undoable disk mode, only one user at a time will have access to a given 
virtual disk fi le.

12. Click Save to save the changes you made to the confi guration fi le.

Set Up the User’s Workstation

The user’s workstation is the computer where you installed VMware in Exercise I. At that computer, 
do the following: 

1. The following steps assume you have installed VMware as outlined in Exercise I. 

2. Create a directory on the local drive named /local/redo/win98 and another named 
~username/vmware/win98 (where username is the user’s login name). 

3. Mount the network drive where you stored the virtual machine fi les.

4. Log out from root and then log in as the user.

5. Copy the CFG fi le from the network drive to the ~username/vmware/win98 directory. 

6. Start VMware using the local confi guration fi le.
cd ~username/vmware/win98
vmware win98.cfg

7. Power on the virtual machine. 

8. If you are using nonpersistent mode, you should receive the following dialog:  
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 Figure 4 - 9

9. This is a reminder that when you are using the nonpersistent mode, all changes will be 
discarded when you reset the virtual machine.  

 
 Figure 4 - 10

10. The above dialog will appear. It is a standard dialog whenever the virtual disks are on a 
mounted network drive

11. If you are using undoable disk mode (fl agged read only), you should receive this dialog instead: 

 
 Figure 4 - 11

12. Click OK. 

13. Verify that Windows 98 boots successfully. 

14. Shut down Windows 98. 

15. If you are using undoable disk mode, you will receive this dialog:  

 
 Figure 4 - 12

16. Click Keep. You will not be allowed to commit the contents of the redo log since the DSK fi le 
has already been fl agged read only. Otherwise, click Discard and your virtual disk will revert to 
its original form the next time you start this virtual machine. 
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17. The next time this virtual machine is restarted, you will receive the following dialog if you 
did not discard the redo log.  

 
 Figure 4 - 13

18. Click Append to allow the new session to add the changes to this redo log. Otherwise, click 
Discard to start the virtual disk in its original form (as if this were the fi rst time you were 
using it). 
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